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 Welcome to Teachucomp, Inc.‟s Advanced Project 

course. This class continues enhancing the student‟s skill 

set with using Microsoft Project, one of the most popular 

project management programs available today. This class 

is designed to give the student with basic knowledge of  

Microsoft Project more advanced project management 

tools and techniques.  

 Microsoft Project is a software application that you can 

use to manage projects in your organization. It provides an 

easy way to enter and track the various project-related 

tasks, budget constraints, and the overall project timeline. 

You can also produce reports that allow you to track and 

manage the project as it is occurring. 
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Advanced Task Management 

8.1- Setting Task Lead and Lag Time: 

 

 You can edit relationship links between tasks within your project file to allow for lag time or lead time 

between tasks. For example, you could allow a day of lag time to pass between tasks. Alternately, you 

could also allow for lead time, where you begin working on a second task before completing all the work on 

a first task. You can edit the duration shown in the “Predecessors” column within the Gantt Chart view of 

your project file to enter a lead time or a lag time. 

 To add a lead time, enter the precedent task reference, followed by the abbreviation for the type of 

link that they share, and then enter the value as a negative value to the precedent task reference. For 

example, assume that you have linked tasks 2 and 3 in your project file with a “Finish-to-Start” task 

relationship. In the “Predecessors” column for task 3, you could enter “2FS - 2d,” which would give you a 

two-day lead time on the task. You can enter either a specific value, or you can enter the value as a 

percentage of the task. For example, entering “2 - 50%” for task 3 would give you a fifty percent lead time 

based on the duration of task 2. 

 If you wish to enter a lag time, enter the precedent task reference, followed by the abbreviation for 

the type of link that they share, and then enter that value as a positive value. For example, assuming that 

you have linked task 2 and 3 in your project file with a “Finish-to-Start” task relationship. If you enter the 

value of “2FS + 1d” into the “Predecessors” column for task 3, you would add one day of lag time to the 

completion of task 2 prior to starting task 3. Just as with the lead time, lag time can be entered as either a 

positive amount, or as a percentage. Note you can enter the lag time and lead time within the “Task 

Information” dialog box on the “Predecessors” tab in the “Lag” column, too. In this case, you simply enter 

the amount to increase or decrease into the field available. Entering a positive value is considered adding 

lag time, and entering a negative value is considered entering lead time. 

8.2- Using Task Constraints: 

 

 All tasks have some type of constraint applied to them. A constraint is simply a scheduling rule that 

determines the start or end time of a task, or otherwise controls the scheduling and rescheduling that is 

available for the task. Constraints allow the scheduling engine within Microsoft Project to reschedule tasks, 

as needed, within a project file. By default, Microsoft Project creates tasks with flexible constraints to allow 

for maximum flexibility in rescheduling. However, you can set the constraints for a task, as desired, to 

produce semi-flexible and inflexible constrains when needed. 

 In Microsoft Project, the available task constraints are grouped into three main groupings: flexible 

constraints, semi-flexible constraints, and inflexible constraints. Flexible constraints, which are used for task 

scheduling by default, allow for tasks to be scheduled without any date-restrictive limitations, with the 

exception being the starting or ending dates of the predecessor and successor tasks within the project file. 

When you use a constraint type such as “As Soon As Possible (ASAP),” you are using a flexible constraint. 

 You can also create semi-flexible constraints, which allow for task scheduling within a date boundary 

that you choose. For example, setting a “Start No Earlier Than” constraint will allow your task to be 

scheduled any time after a specified date has passed. This is an example of using a semi-flexible 

constraint. You can also create inflexible constraints. Using inflexible constraints prevents the rescheduling 

of the task. For example, using the “Must Start On” constraint forces a task to begin on the date specified. 

When you specify an inflexible constraints, the task will never be automatically rescheduled for any reason. 

 In Microsoft Project, you can set the task constraints within the “Task Information” dialog box on the 

“Advanced” tab by using the “Constraint type:” and “Constraint date:” drop-down menus. Simply select the 

type of constraint to apply from the “Constraint type:” drop-drown and, if necessary, select a date from the 

“Constraint date:” drop-down. Click the “OK” button to save the task when you are finished. Sa
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Advanced Task Management 

8.3- Task Types: 

 

 When you record actual work completed, or progress made, on a task in your project file, Microsoft 

Project will recalculate remaining task duration, by default. When calculating the work value of a task after 

updating either the work, duration, or unit values, Microsoft Project uses a formula, called the scheduling 

formula, to recalculate the task‟s remaining work value. The scheduling formula is: Work = Duration x Units. 

Note that “Units,” refers to the resource assignment units, often entered as a percentage. 

 When you create tasks within your project file, the task has an associated “Task Type” that you can 

set on the “Advanced” tab within the “Task Information” dialog box. Each task type corresponds to each 

element of the scheduling formula. The task type determines which of the elements in the formula will 

remain constant if one of the other two is changed. 

 The default task type is “Fixed Units.” Using this task type allows you to change the duration of a 

task, and let Project recalculate the work remaining, or vice versa. However, you can change this setting to 

select either “Fixed Duration” or “Fixed Work.” If you choose to create a “Fixed Duration” task, you can 

change either the work or unit values, and Project will recalculate the other value. If you select a “Fixed 

Work” task type, you can change either the task‟s unit or duration values, and Project will recalculate the 

other value. Also note that you cannot disable “effort-driven scheduling” on a “Fixed Work” task type. 

 Also important to note is that assigning a task type allows you to enter actual work, or progress, 

values for your task and then let Project update the other values. This does not mean that you cannot 

change the “fixed” value for the task. You can always change any value (duration, units, work) for a 

task, regardless of the task type that is applied to the task. The “fixed” aspect simply refers to which 

element (variable) in the scheduling equation is held constant when recalculating work values on the task. 

8.4- Setting Deadlines: 

 

 Many new users of Microsoft Project accidentally make the mistake of using of too many semi-

flexible and inflexible constraints when creating their tasks within a project file. This often comes from the 

urge to set “Must Finish On” constraints, or actual “Finish” dates when creating their tasks, which often will 

produce an inflexible or semi-flexible constraint on the task. The problem that often occurs when creating 

tasks in this manner is that you severely limit the task rescheduling potential of Microsoft Project. 

 A better way to set deadlines for tasks is to simply set a deadline date for a task, and use the default 

“As Soon As Possible (ASAP)” constraint. This way, Project can reschedule the task with the greatest 

flexibility, and you will also be able to view the deadline date for the task in the Gantt Chart. 

 To set a deadline date for a task, open the “Task Information” dialog box and click the “Advanced” 

tab within the “Task Information” dialog box. You then select the desired deadline date from the “Deadline:” 

drop-down. Finally, click the “OK” button to set the deadline date for the task. 

 You should now see a deadline date indicator appear for that task row within the Gantt Chart view of 

your project file. If the task is ever scheduled beyond the deadline date, Microsoft Project will display a 

“Missed Deadline” indicator for that task in the “Indicators” column in the Gantt Chart view. 
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Advanced Task Management 

8.5- Interrupting Tasks: 

 

 Despite your best efforts in planning, there will inevitably be times when work on a task will be 

interrupted. This may be due to an unplanned event or even a task reprioritization. Either way, you can 

interrupt work on a task by using the split task function within Microsoft Project. This feature allows you to 

split, or interrupt, a task in order to accommodate planned and unplanned breaks in the work on the task. 

 In order to split a task, select the task in the Gantt Chart view in the project file. Then click the “Split 

Task” button in the “Schedule” button group on the “Task” tab in the Ribbon. At this point, your mouse 

pointer icon changes to the “split task” icon. Simply place this icon over the date at which you want to split 

the task in the bar chart part of the Gantt Chart view, and then click and drag the task to the right in order to 

create a split. As you click and drag, you will see the new “Start Date” shown is a small yellow text box 

called a screen tip. This tip helps you see the start date for the second segment of the split task. When the 

date shown in the screen tip is correct, simply release the mouse button. 

 If you dragged the second segment to the wrong date by accident, you can just click and drag the 

second segment until the start date of the second segment is on the desired date. This can happen as you 

are first learning to split tasks with your mouse. Also note that you can split a task multiple times, as 

needed. However, you can only split a task into the smallest increments displayed on the timescale view in 

the bar chart area of the Gantt Chart. For example, if you wish to split a task by hours, then you must 

ensure that the smallest time increment displayed in the timescale area are the hours. 

8.6- Creating Recurring Tasks: 

 

 Some tasks in a project file are standard and repetitive- such as a weekly project coordination 

conference meeting. You can enter these types of tasks as recurring tasks within your project file so that 

you can create that task once and then have it recur on a regular basis without having to enter a separate 

task for each instance of the meeting. When you create a recurring task, the tasks that are created all 

contain a “Start No Earlier Than” constraint, no task links, and no effort-driven scheduling. 

 To create a recurring task in your project file, select the blank task line in the Gantt Chart view where 

you wish to insert the new recurring task. Then click the “Task” drop-down button in the “Insert” button 

group on the “Task” tab in the Ribbon. From the drop-down menu that appears, select the “Recurring 

Task…” command in order to open the “Recurring Task Information” dialog box. First, type a name for the 

task into the “Task Name” field. You can then input the duration of the recurring task in the adjacent 

“Duration” field. 

 Next, in the “Recurrence pattern” section of the dialog box, you set the pattern of recurrence for the 

task. The choices shown depend upon whether you choose to set a “Daily,” “Weekly,” “Monthly,” or “Yearly” 

pattern. Once you have selected an option, set the specifics for the option in the area to the right. 

 Next, in the “Range of recurrence” section, enter the first “Start” date of the first instance of the task. 

Then, to the right of that, set the ending date, or select the total number of times that you want the task to 

occur. In the “Calendar for scheduling this task” area, use the “Calendar” drop-down to select the desired 

working schedule calendar. Once you have finished, click the “OK” button to save the recurring task. 
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Advanced Task Management 

8.7- Entering Fixed Costs: 

 

 You may have fixed costs associated with a task in your project file. A fixed cost is usually a one-

time charge that is needed in order to accomplish the task. For example, having to pay a permit fee for a 

construction project could be an example of a fixed cost. 

 You can easily enter fixed costs into the “Costs” view of the table in the Gantt Chart view. To do this, 

select the task for which you want to enter the fixed costs. Next, click the “Tables” drop-down button in the 

“Data” button group on the “View” tab in the Ribbon. From the drop-down menu that appears, select the 

“Cost” choice. In the new “Fixed Cost” column that appears next to the tasks, you can then enter the amount 

to set as a fixed cost for the task. This total amount will then be added to other resource costs within project 

reports for the task. 

 If you wish to set the table view back to the default “Entry” view, then click the “Tables” drop-down 

button in the “Data” button group on the “View” tab in the Ribbon. From the drop-down menu that appears, 

select the “Entry” choice. 

8.8- Critical Paths: 

 

 As used within Microsoft Project, a critical path is the set of tasks that, if delayed, would extend the 

end date of a project file. The term “critical,” as used in this context, has nothing to do with the importance of 

the task to the overall completion of the project. Rather, it is called a critical task if its delay would extend 

the ending date of the project. Therefore, the critical path of a project is the path of tasks within a project file 

that cannot be delayed without delaying the entire project deadline. When dealing with a project that has 

fallen behind schedule, these are the tasks whose duration must also be shortened if you are to “bring in” 

the project‟s deadline. The process of shortening the duration of the critical tasks in the critical path in order 

to shorten the project deadline is also called “crashing the critical path.” 

 In order to view the critical path in your project file, you can switch the view of your project file to the 

“Tracking Gantt” view. In order to apply this view, click the “Gantt Chart” drop-down button in the “View” 

button group on the “Task” tab in the Ribbon. Then select the “Tracking Gantt” choice from the drop-down 

menu that appears. 

 In the “Tracking Gantt” view, Microsoft Project shows critical task bars in red and noncritical task 

bars in blue within the bar chart area. For noncritical tasks, the thin teal line represents the slack time 

associated with the task. 
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ACTIONS- 

Advanced Task Management 
SETTING LEAD AND LAG TIME: 

 

1. To enter a lead time or a lag time, you can simply edit the value shown in the cell within the 

“Predecessors” column for the selected task in the Gantt Chart view. 

2. To add a lead time, enter the precedent task reference, followed by the abbreviation for the type of link 

that they share, and then enter the value as a negative value to the precedent task reference. 

3. If you wish to enter a lag time, enter the precedent task reference, followed by the abbreviation for the 

type of link that they share, and then enter that value as a positive value. 

4. Also note that you can enter the lag time and lead time within the “Task Information” dialog box on the 

“Predecessors” tab in the “Lag” column, if preferred. Note that entering a positive value is considered 

adding lag time, and entering a negative value is considered entering lead time. 

USING TASK CONSTRAINTS: 

 

1. Open the “Task Information” dialog box and then click the “Advanced” tab within the “Task Information” 

dialog box. 

2. Simply select the type of constraint to apply from the “Constraint type:” drop-drown and, if necessary, 

select a date from the “Constraint date:” drop-down. 

3. Click the “OK” button to save the task when you are finished. 

SETTING TASK TYPES: 

 

1. Open the “Task Information” dialog box and then click the “Advanced” tab within the “Task Information” 

dialog box. 

2. Use the “Task Type” drop-down to set the desired setting for the task type. The default task type is 

“Fixed Units.” Using this task type allows you to change the duration of a task, and let Project 

recalculate the work remaining, or vice versa. However, you can change this setting to select either 

“Fixed Duration” or “Fixed Work.” If you choose to create a “Fixed Duration” task, you can change either 

the work or unit values, and Project will recalculate the other value. If you select a “Fixed Work” task 

type, you can change either the task‟s unit or duration values, and Project will recalculate the other 

value. Also note that you cannot disable “effort-driven scheduling” on a “Fixed Work” task type. 

SETTING DEADLINES: 

 

1. Open the “Task Information” dialog box and then click the “Advanced” tab within the “Task Information” 

dialog box. 

2. You then select the desired deadline date from the “Deadline:” drop-down. 

3. Finally, click the “OK” button to set the deadline date for the task. 

4. You should now see a deadline date indicator appear for that task row within the Gantt Chart view of 

your project file. If the task is ever scheduled beyond the deadline date, Microsoft Project will display a 

“Missed Deadline” indicator for that task in the “Indicators” column in the Gantt Chart view. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



11 Advanced Project ©TeachUcomp, Inc. 

ACTIONS- 

Advanced Task Management 
INTERRUPTING TASKS: 

 

1. In order to split a task, select the task to split within the Gantt Chart view in the project file. 

2. Then click the “Split Task” button in the “Schedule” button group on the “Task” tab within the Ribbon. 

3. At this point, your mouse pointer icon changes to the “split task” icon. Simply place this icon over the 

date at which you want to split the task in the bar chart part of the Gantt Chart view, and then click and 

drag the task to the right in order to create a split. 

4. As you click and drag, you will see the new “Start Date” shown is a small yellow text box called a screen 

tip. This tip helps you see the start date for the second segment of the split task. When the date shown 

in the screen tip is correct, simply release the mouse button. 

5. If you dragged the second segment to the wrong date by accident, you can just click and drag the 

second segment until the start date of the second segment is on the desired date. 

6. Also note that you can split a task multiple times, as needed. However, you can only split a task into the 

smallest increments displayed on the timescale view in the bar chart area of the Gantt Chart. For 

example, if you wish to split a task by hours, then you must ensure that the smallest time increment 

displayed in the timescale area are the hours. 

CREATING RECURRING TASKS: 

 

1. To create a recurring task in your project file, select the blank task line in the Gantt Chart view where 

you wish to insert the new recurring task. 

2. Click the “Task” drop-down button in the “Insert” button group on the “Task” tab within the Ribbon. 

3. Select the “Recurring Task…” command from the drop-down menu that appears. 

4. Type a name for the task into the “Task Name” field. 

5. You can then input the duration of the recurring task in the adjacent “Duration” field. 

6. Next, in the “Recurrence pattern” section of the dialog box, you set the pattern of recurrence for the task. 

The choices shown depend upon whether you choose to set a “Daily,” “Weekly,” “Monthly,” or “Yearly” 

pattern. Once you have selected an option, set the specifics for the option in the area to the right. 

7. Next, in the “Range of recurrence” section, enter the “Start” date of the first instance of the task. Then, to 

the right of that, set the ending date, or select the total number of times you want the task to occur. 

8. In the “Calendar for scheduling this task” area, use the “Calendar” drop-down to select the desired 

working schedule calendar. 

9. Once you have finished, click the “OK” button to save the recurring task. 

ENTERING FIXED COSTS: 

 

1. You can easily enter fixed costs into the “Costs” view of the table in the Gantt Chart view. To do this, 

select the task for which you want to enter the fixed costs. 

2. Click the “Tables” drop-down button in the “Data” button group on the “View” tab in the Ribbon. 

3. From the drop-down menu that appears, select the “Cost” choice. 

4. In the new “Fixed Cost” column that appears next to the tasks, you can then enter the amount to set as 

a fixed cost for the task. This total amount will then be added to other resource costs within project 

reports for the task. 

5. If you wish to set the table view back to the default “Entry” view, click the “Tables” drop-down button in 

the “Data” button group on the “View” tab in the Ribbon. 

6. From the drop-down menu that appears, select the “Entry” choice Sa
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ACTIONS- 

Advanced Task Management 
VIEWING THE CRITICAL PATH OF A PROJECT FILE: 

 

1. In order to view the critical path in your project file, you can switch the view of your project file to the 

“Tracking Gantt” view. 

2. In order to apply this view, click the “Gantt Chart” drop-down button in the “View” button group on the 

“Task” tab in the Ribbon. 

3. Then select the “Tracking Gantt” choice from the drop-down menu that appears. 

4. In the “Tracking Gantt” view, Microsoft Project shows critical task bars in red and noncritical task bars in 

blue in the bar chart area. For noncritical tasks, the thin teal line represents the slack time associated 

with the task. 
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EXERCISES- 

Advanced Task Management 
Purpose: 

 

1. To be able to perform advanced task management within a project file.  

Exercises: 

 

1. Open the “My Project” project file that contains the saved changes that were made to the file through 

the end of the final chapter‟s exercises in the “Introductory Project” manual. 

2. Click the “Gantt Chart” button in the “View” button group on the “Task” tab within the Ribbon to 

display the “Gantt Chart” view for the “My Project” project file, if needed. 

3. Select task number 10 (Create review and feedback) in the task list within the Gantt Chart view. 

4. Type “7FS + 1d” into the “Predecessors” column for task 10, and be sure to exit the cell to save your 

entry. This will add one day of lag time to the selected task. 

5. Click the “Save” button in the Quick Access toolbar to save your changes. 

6. Select task number 4 (Create evaluative feedback) in the task list within the Gantt Chart view. 

7. Click the “Information” button within the “Properties” button group on the “Task” tab in the Ribbon in 

order to open the “Task Information” dialog box for the selected task. 

8. Click the “Advanced” tab within the dialog box, and then type “2/9/12” into the “Deadline” text box in 

order to set a deadline date for the task. 

9. Click the “OK” button in the dialog box to save your changes to the task. 

10. In order to display the critical path for the project file, click the “Gantt Chart” drop-down button in the 

“View” button group on the “Task” tab in the Ribbon. 

11. Select the “Tracking Gantt” choice from the drop-down menu that appears. 

12. Note the display of the critical path and free slack within the project file. 

13. Click the “Gantt Chart” drop-down button in the “View” button group on the “Task” tab in the Ribbon. 

14. Select the “Gantt Chart” choice from the drop-down menu that appears to restore the default display 

of the project file. 

15. Click the “Save” button within the Quick Access toolbar to save your changes. 

16. Click the “x” in the upper-right corner of the project file window to close the sample project file that 

you just saved. You will continue to use this file to complete the upcoming sequential 

exercises throughout this entire course. Each exercise builds upon the previous exercise, so 

please complete them in the order given to maximize your overall learning experience. 
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CHAPTER 9- 

Advanced Resource Management 

9.1- Applying Multiple Resource Rates 

 

9.2- Advanced Resource Availability 

 

9.3- Using Work Contours 

 

9.4- Material Resource Consumption Rates 

 

9.5- Delaying Resource Assignments 
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Advanced Resource Management 

9.1- Applying Multiple Resource Rates: 

 

 After you have created your work resources, you can designate various cost rates for the resources 

within the cost rate tables shown in the “Resource Information” dialog box on the “Costs” tab. Within a cost 

rate table, you can have multiple pay rates for overtime and standard pay, and you can also specify when 

the “Effective Dates” when the rates should be applied, if pay rates change mid-project. 

 In this lesson we will examine applying various cost rates to work resources when they are assigned 

to a task by using the various cost tables. This can be useful when dealing with a single resource that may 

earn two entirely different pay rates based upon the type of work that they perform within the project. For 

example, you could create cost table A for plumbing work, and cost table B for electrical work for a work 

resource that could perform both tasks within a single project. You would then need to specify which rate 

applied to which tasks within the project file when assigning this work resource to tasks. In this lesson, we 

will learn to change which cost table rate is applied when you assign a work resource to a task. 

 In order to enter the necessary information, you will need to first switch to the “Task Usage” view of 

the project file. To do this, click the “Gantt Chart” drop-down button in the “View” group on the “Task” tab in 

the Ribbon. Then select the “Task Usage” command from the drop-down menu. 

 Next, click the “Tables” drop-down button in the “Data” group on the “View” tab in the Ribbon, and 

select the “Cost” command from the drop-down menu. 

 Now you will want to select the assigned work resource whose cost rate table you want to change 

for the desired task within the project file. Once you have the name of the assigned resource within the 

desired task selected, click the “Information” button in the “Assignment” group on the “Task Usage Tools” 

contextual tab within the Ribbon. 

 In the “Assignment Information” dialog box that appears, click the “General” tab. On this tab you will 

see the assignment information for the selected resource for this task. Use the “Cost rate table:” drop-down 

arrow to choose which cost rate table to use for this task. Then click the “OK” button to apply the new rate to 

the work assignment for that task. 

9.2- Advanced Resource Availability: 

 

 For many project types, you can create work resources that fit a general type of work. For example, 

if creating a software development project file, you could have a “programmer” work resource as a general 

type of work resource. Now assume that the first week of the project you will have one programmer, then 

two programmers for the second week, and finally three programmers for the remainder of the project. 

 In this case, you can use the “Max Units” field inside of the “Resource Availability” table within the 

“Resource Information” dialog box for the “programmer” work resource to set the maximum hours of 

availability of the programmer work resource for the different time periods. This is similar to setting different 

pay rates for work resources, only this time we are changing the maximum number of hours available for 

the  different time periods within a project for a single, generalized type of work resource. 

 To do this, first switch your project file to the “Resource Sheet” view by clicking the “Gantt Chart” 

drop-down button in the “View” group on the “Task” tab in the Ribbon, and then selecting the “Resource 

Sheet” command from the button‟s drop-down menu. 

 Next, select the desired work resource whose resource availability you wish to change from the 

listing shown in the “Resource Sheet” view of your project file. Then click the “Information” button in the 

“Properties” group on the “Resource” tab in the Ribbon in order to display the “Resource Information” dialog 

box. 

 Next, use the “Available From,” “Available To,” and “Units” fields within the “Resource Availability” 

table on the “General” tab to set the dates and resource availability for the desired resource. Using the 
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Advanced Resource Management 

9.2- Advanced Resource Availability (cont.): 

 

example given earlier, you would select the dates of the first week of your project and enter 100% 

availability for the “Units.” Then select the start and end dates of the second week of your project from the 

“Available From” and “Available To” drop-downs, and then set 200% for the units. You would then repeat 

this step for the third week, selecting the desired effective date to start and setting the units to 300% for the 

remainder of the project. This allows Microsoft Project to accurately schedule the work based on the 

resource availability. 

 Once you have finished setting your resource availability in this dialog box, click the “OK” button to 

set the new availability rates. 

9.3- Using Work Contours: 

 

 Within many types of tasks in many types of projects, the workload may not be evenly distributed 

throughout the task duration. Some tasks have more work involved in the beginning, or towards the end, of 

the task‟s duration. These are often referred to as “front-loaded” or “back-loaded” tasks, respectively. While 

you can manually edit the assignment details directly to account for the actual work, you can also apply 

work contours to tasks with a fairly predictable workload to distribute the workload over the task duration. 

 To apply a work contour to a task, switch to the “Task Usage” view of the project file by clicking the 

“Gantt Chart” drop-down button in the “View” group on the “Task” tab in the Ribbon and then selecting the 

“Task Usage” command from the drop-down menu. 

 Next, select the work resource assigned to a task within the “Task Usage” view. Once you have 

done that, click the “Information” button in the “Assignment” group on the “Task Usage Tools” contextual tab 

within the Ribbon in order to open the “Assignment Information” dialog box. 

 On the “General” tab within this dialog box, you can then use the “Work contour:” drop-down to 

select the desired work contour to apply to the work resource for the selected task. 

 Finally, click the “OK” button to apply the selected work contour to the work assignment. 

9.4- Material Resource Consumption Rates: 

 

 When assigning material resources to tasks, you can specify two different types of resource 

consumption rates. You can either specify a fixed consumption rate for a task, or you can specify a variable 

consumption rate. For example, if you set “paper” as a resource for a “writing” task, you could create it with 

a variable consumption rate, so that the amount of paper used could vary based on the duration of the 

“writing” task. 

 In order to use a variable consumption rate with a material resource when assigning the material 

resource to a task, you can use the “Assign Resources” dialog box. Select the task to which you want to 

assign the material resource, and then click the “Assign Resources” button in the “Assignments” group on 

the “Resource” tab in the Ribbon in order to display the “Assign Resources” dialog box. 

 Select the material resource that you wish to assign from the list shown, and then click into the 

“Units” field. Next, enter the rate of consumption used for the task. For example, assume that you used 5 

units of the selected resource per unit of task duration. In this case, you would enter “5” into the “Units” field 

to indicate a resource usage rate of 5 per unit. 

 When you have finished, click the “Assign” button to assign the material resource to the task. You 

can then click the “Close” button within the “Assign Resources” dialog box to close it. Sa
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Advanced Resource Management 

9.5- Delaying Resource Assignments: 

 

 At times, you can delay the start of work for an assigned work resource on a task when there are 

multiple work resources assigned to a task. For example, you could delay the start of one work resource on 

a task by 4 hours if the work resource was to inspect the work produced by two other work resources 

assigned to the same task. In this case, you can enter an actual “Start” date and time for the work resource 

when assigning it to the task. 

 To do this, first switch to the “Task Usage” view to see assignment detail. Next, select the assigned 

work resource whose start date you wish to delay from the listing shown. 

 Then click the “Information” button in the “Assignment” group on the “Task Usage Tools” contextual 

tab within the Ribbon to display the “Assignment Information” dialog box. 

 You can then enter a specific start date or start date and time into the “Start” field on the “General” 

tab within this dialog box. This will delay the start of work for the selected resource until the date and/or date 

and time specified, while still allowing for automatic scheduling of other work resources on the same task. 

 When you have finished specifying a start time for the selected resource, click the “OK” button in the 

“Assignment Information” dialog box to close it. 
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ACTIONS- 

Advanced Resource Management 
APPLYING MULTIPLE RESOURCE RATES: 

 

1. Switch to the “Task Usage” view of the project file by clicking the “Gantt Chart” drop-down button in the 

“View” group on the “Task” tab in the Ribbon and then selecting the “Task Usage” command from the 

drop-down menu. 

2. Click the “Tables” drop-down button in the “Data” group on the “View” tab in the Ribbon, and select the 

“Cost” command from the drop-down menu. 

3. Now you will want to select the assigned work resource whose cost rate table you want to change for 

the desired task within the project file. 

4. Once you have the name of the assigned resource within the desired task selected, click the 

“Information” button in the “Assignment” group on the “Task Usage Tools” contextual tab within the 

Ribbon. 

5. In the “Assignment Information” dialog box that appears, click the “General” tab. 

6. On this tab you will see the assignment information for the selected resource for this task. Use the “Cost 

rate table:” drop-down arrow to choose which cost rate table to use for this task. 

7. Click the “OK” button to apply the new rate to the work assignment for that task. 

SETTING ADVANCED RESOURCE AVAILABILITY: 

 

1. Switch your project file to the “Resource Sheet” view by clicking the “Gantt Chart” drop-down button in 

the “View” group on the “Task” tab in the Ribbon, and then selecting the “Resource Sheet” command 

from the button‟s drop-down menu. 

2. Select the desired work resource whose resource availability you wish to change from the listing shown 

in the “Resource Sheet” view of your project file. 

3. Click the “Information” button in the “Properties” group on the “Resource” tab in the Ribbon in order to 

display the “Resource Information” dialog box. 

4. Next, use the “Available From,” “Available To,” and “Units” fields within the “Resource Availability” table 

on the “General” tab to set the dates and resource availability for the desired resource. 

5. Once you have finished setting your resource availability in this dialog box, click the “OK” button to set 

the new availability rates 

USING WORK CONTOURS: 

 

1. Switch to the “Task Usage” view of the project file by clicking the “Gantt Chart” drop-down button in the 

“View” group on the “Task” tab in the Ribbon and then selecting the “Task Usage” command from the 

drop-down menu. 

2. Select the work resource assigned to a task within the “Task Usage” view. 

3. Click the “Information” button in the “Assignment” group on the “Task Usage Tools” contextual tab within 

the Ribbon in order to open the “Assignment Information” dialog box. 

4. On the “General” tab within this dialog box, you can then use the “Work contour:” drop-down to select 

the desired work contour to apply to the work resource for the selected task. 

5. Click the “OK” button to apply the selected work contour to the work assignment. 
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ACTIONS- 

Advanced Resource Management 

DELAYING RESOURCE ASSIGNMENTS: 

 

1. Switch your project file to the “Resource Sheet” view by clicking the “Gantt Chart” drop-down button in 

the “View” group on the “Task” tab in the Ribbon, and then selecting the “Resource Sheet” command 

from the button‟s drop-down menu. 

2. Select the assigned work resource whose start date you wish to delay from the listing shown. 

3. Click the “Information” button in the “Assignment” group on the “Task Usage Tools” contextual tab within 

the Ribbon to display the “Assignment Information” dialog box. 

4. You can then enter a specific start date or start date and time into the “Start” field on the “General” tab 

within this dialog box. This will delay the start of work for the selected resource until the date and/or date 

and time specified, while still allowing for automatic scheduling of other work resources on the same 

task. 

5. When you have finished specifying a start time for the selected resource, click the “OK” button in the 

“Assignment Information” dialog box to close it. 

SETTING A VARIABLE MATERIAL CONSUMPTION RATE: 

 

1. Select the task to which you want to assign the material resource, and then click the “Assign Resources” 

button in the “Assignments” group on the “Resource” tab in the Ribbon in order to display the “Assign 

Resources” dialog box. 

2. Select the material resource that you wish to assign from the list shown, and then click into the “Units” 

field. 

3. Enter the rate of consumption used for the task. For example, assume that you used 5 units of the 

selected resource per unit of task duration. In this case, you would enter “5” into the “Units” field to 

indicate a resource usage rate of 5 per unit. 

4. When you have finished, click the “Assign” button to assign the material resource to the task. 

5. You can then click the “Close” button within the “Assign Resources” dialog box to close it. 
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EXERCISES- 

Advanced Resource Management 
Purpose: 

 

1. To be able to enter work resource rate changes within a project file.  

Exercises: 

 

1. Open the “My Project” project file that contains the saved changes that were made to the file through the 

end of the previous chapter‟s exercises. 

2. Switch your project file to the “Resource Sheet” view by clicking the “Gantt Chart” drop-down button in 

the “View” group on the “Task” tab in the Ribbon, and then selecting the “Resource Sheet” command 

from the button‟s drop-down menu in order to view the resources available to the project file. 

3. Select resource number 1 (Jon Doe) from the resource list. 

4. Click the “Information” button in the “Properties” group on the “Resource” tab in the Ribbon in order to 

open the “Resource Information” dialog box. 

5. Click the “Costs” tab with the “Resource Information” dialog box. 

6. Enter the following “mid-project pay raise” information for Jon Doe into cost table A (Default) shown in 

the “Costs” tab. 

 

 

 

 

 

 

 

 

 

 

 

7. Click the “OK” button within the “Resource Information” dialog box in order to save the resource details 

changes. 

8. Click the “Save” button within the Quick Access toolbar to save your changes. 

9. Click the “x” in the upper-right corner of the project file window to close the sample project file that you 

just saved. You will continue to use this file to complete the upcoming sequential exercises 

throughout this entire course. Each exercise builds upon the previous exercise, so please 

complete them in the order given to maximize your overall learning experience. 
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CHAPTER 10- 

Advanced Project Tracking 

10.1- Monitoring Resource Allocation 

 

10.2- Leveling Overallocated Resources 

 

10.3- Monitoring Project Costs 

 

10.4- Monitoring Project Statistics 
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Advanced Project Tracking 

10.1- Monitoring Resource Allocations: 

 

 As you complete the work on your project file, you should monitor your resource allocation. You may 

be under-using resources that you could otherwise utilize, which is called underallocating resources. 

Perhaps more importantly, you may also accidentally be overallocating resources, trying to schedule more 

work to a resource than is possible in a given time period. In this lesson, we will examine how to monitor 

your resource allocation within your project file. 

 One useful view that allows you to see resource allocations is the “Resource Usage” view of your 

project file. You can click the “Gantt Chart” drop-down button in the “View” group on the “Task” tab and then 

select the “Resource Usage” command to see this view. This view show resources, work contours, and 

resource allocation issues. Within this view, overallocated work resources are displayed in red. One way to 

change resource overallocation is to manually change the hours assigned to the selected resource, or to 

add additional work resources to the tasks to which the overallocated resource has been assigned- thereby 

reducing the hours for the selected resource. Another way to resolve overallocation is by using automatic 

leveling available in Microsoft Project. In the next lesson, we will examine how to automatically level 

overallocated resources. 

10.2- Leveling Overallocated Resources: 

 

 As we saw in the previous lesson, you can use the “Resource Usage” view of the project file to 

examine resource allocation. You can also make manual adjustments to the overallocated work resource in 

order to ensure that it remains fully allocated based on the “Units” of work available. In addition to manually 

correcting overallocated resources, you can automatically level overallocated resources in Microsoft 

Project. When you automatically level resource overallocations, Microsoft Project will either delay the start 

times of tasks, delay the work resource assignments for a task, or split tasks durations, in order to resolve 

the conflicts. It will not change task assignments or unit values of the assignments. If you wish to resolve 

resource overallocation by assigning additional work resources, you must do that manually. 

 To set the parameters used to automatically resolve resource overallocations, you can click the 

“Leveling Options” button in the “Level” group on the “Resource” tab in the Ribbon to open the “Resource 

Leveling” dialog box. This dialog box allows you to control the processes and guidelines that Microsoft 

Project will use when performing the resource leveling. Note that the settings that you make here will be 

applied to all project files that you use, and not just the currently selected project file. For this reason, it is 

recommended that you do not select the “Automatic” choice within the “Resource Leveling” dialog box, as 

that will apply resource leveling in all project files, whether you want it or not, which can cause more 

problems than it corrects. Leave the “Manual” option shown in the “Leveling calculations” section selected in 

order to allow for resource leveling only when you select to apply it. 

 Next, use the “Look for overallocations on a” drop-down to select the basis to be used for resource 

overallocation examination. Note that choosing a level of inspection that is finer than a “Day by Day” basis 

may result in many, unnecessary adjustments to the work schedule. Use care if selecting a level of 

inspection finer than the “Day by Day” basis. 

 Next, decide whether or not you wish to remove any leveling adjustments before applying the new 

leveling. If you wish to clear old leveling adjustments before applying the leveling adjustments that you are 

about to create, then leave the “Clear leveling values before leveling” checkbox checked. 

  Next, in the “Leveling range for” section, you can set the specific range of leveling to use within this 

project file. If you wish to level the whole project, leave the “Level entire project” option selected. Otherwise, 

you can use the “From” and “To” drop-downs in order to select the range within the project file to inspect. Sa
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Advanced Project Tracking 

10.2- Leveling Overallocated Resources (cont.): 

 

 You next choose the guidelines to use for leveling from the choices shown in the “Resolving 

overallocations” section of the “Resource Leveling” dialog box. For most projects, ensure that the 

“Standard” choice is selected from the “Leveling order:” drop-down. This resource leveling method respects 

the task relationships between the tasks in your project file, and is therefore the most commonly used. 

 Next, if you want to allow the leveling to only use the available free slack within the project file, then 

select the “Level only within available slack” checkbox. This choice is most often unchecked, in order to 

allow Microsoft Project to extend the finish date of the project in order to resolve overallocations. Often, 

there is not enough free slack in a project file to allow for resolution of overallocated resources without 

extending the finish date. 

 You can check the “Leveling can adjust individual assignments on a task” checkbox in order to allow 

Project the ability to add leveling delay to individual work resource assignments on a task, independently of 

the other assigned work resources. 

 You can check the “Leveling can create splits in remaining work” checkbox to allow Project to split a 

task, or work assignment on a task, in order to resolve resource overallocation. 

 If you are using Microsoft Project Professional, you may also see a “Level resources with the 

proposed booking type” checkbox. You will most often leave this checkbox cleared when leveling 

resources. 

 You can also check the “Level manually scheduled tasks” checkbox to include manually scheduled 

tasks in the leveling process within this project file. 

 Next, click the “Level All” button when you are ready to level the entire project file. Doing this 

corresponds to clicking the “Level All” button in the “Level” group on the “Resource” tab in the Ribbon. Also 

note that you can click the “Level Selection” and “Level Resource” buttons in this same button group to level 

a selected task or resource within your project file if you wish to manually level resources one at a time. If 

you decide to manually level each resource or task individually within a project file, you can also use the 

“Next Overallocation” button in this group to select the next resource overallocation to resolve. 

 You can also clear a resource leveling that you have applied by clicking the “Clear Leveling” button 

in this button group. When you do this, a “Clear Leveling” dialog box will appear where you can choose 

either “Entire project” or “Selected tasks.” Simply make your choice, and then click the “OK” button to 

remove the resource leveling that you have applied. 

10.3- Monitoring Project Costs: 

 

 While monitoring resource allocation and task duration is a very important part of project 

management, monitoring project costs is another very important aspect of many projects. You can see 

much of the cost data that you need to monitor within the “Cost” table in the table view of your project file. 

You can switch the view of your project file to display this data easily. To do this, click into the table within 

the “Gantt Chart” view. Then click the “Tables” drop-down button in the “Data” group on the “View” tab in the 

Ribbon and select the “Cost” command from the drop-down menu. Remember that you can select the 

“Entry” command from this same drop-down menu to reset the display of the table area within the view to 

the basic task entry view when finished examining costs, if desired. 

 Generally, some of the most important costs that are requested regarding a project are shown in the 

“Costs” table. However, you can also generate reports that display this type of data within Project, as well. 

You can see baseline costs, which are the scheduled costs that were saved as part of the project baseline. 

You can also see current costs, which are the costs that are scheduled for the task. After costs have been 
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Advanced Project Tracking 

10.3- Monitoring Project Costs (cont.): 

 

incurred, this shows the actual costs plus remaining costs. This information is displayed in the “Costs” or 

“Total Costs” column. You can also see the actual costs, which are the costs that have been incurred for 

tasks, assignments, and resources. You can also see remaining costs, which is the difference between the 

current costs and the actual costs for the task, assignment, or resource. 

10.4- Monitoring Project Statistics: 

 

 As you make adjustments to your project file, you should check your project statistics and finish 

date. You can access this type of information within your project file by clicking the “Project Information” 

button in the “Properties” group on the “Project” tab within the Ribbon in order to open the “Project 

Information” dialog box. Here you will see the scheduled finish date of the project shown in the “Finish date” 

field. This is important to keep track of as you level resources and adjust the tasks within your project file. 

 Also notice that you can click the “Statistics…” button to display the “Project Statistics” dialog box for 

your project file. This dialog box shows the “Current,” “Baseline,” “Actual,” and “Variance” for the “Start” and 

“Finish” dates of your project file. You can also see the “Current,” “Baseline,” “Actual,” and “Remaining” 

values for the project file‟s “Duration,” “Work,” and “Cost.” When you are finished viewing this data, click the 

“Close” button to close the dialog box. 
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ACTIONS- 

Advanced Project Tracking 
MONITORING RESOURCE ALLOCATION: 

 

1. One useful view that allows you to see resource allocations is the “Resource Usage” view of your 

project file. You can click the “Gantt Chart” drop-down button in the “View” group on the “Task” tab and 

then select the “Resource Usage” command to see this view. 

2. This view show resources, work contours, and resource allocation issues. Within this view, 

overallocated work resources are displayed in red. 

LEVELING OVERALLOCATED RESOURCES: 

 

1. To set the parameters used to automatically resolve resource overallocations, you can click the 

“Leveling Options” button in the “Level” group on the “Resource” tab in the Ribbon. 

2. In the “Resource Leveling” dialog box that opens, leave the “Manual” option shown in the “Leveling 

calculations” section selected in order to allow for resource leveling only when you select to apply it. 

3. Use the “Look for overallocations on a” drop-down to select the basis to be used for resource 

overallocation examination. Note that choosing a level of inspection that is finer than a “Day by Day” 

basis may result in many, unnecessary adjustments to the work schedule. 

4. If you wish to clear old leveling adjustments before applying the leveling adjustments that you are about 

to create, then leave the “Clear leveling values before leveling” checkbox checked. 

5. In the “Leveling range for” section, you can set the range of leveling to use within this specific project 

file. If you wish to level the whole project, leave the “Level entire project” option selected. Otherwise, use 

the “From” and “To” drop-downs to select the date range within the project file to inspect. 

6. Choose the guidelines to use for leveling from the choices shown in the “Resolving overallocations” 

section. For most projects, ensure the “Standard” choice is selected from the “Leveling order:” drop-

down. This leveling method respects the task relationships between the tasks in your project file. 

7. To allow leveling to only use the available free slack within the project file, select the “Level only within 

available slack” checkbox. This choice is most often unchecked. 

8. You can check the “Leveling can adjust individual assignments on a task” checkbox to allow leveling 

delay to individual resource assignments on a task, independently of the other assigned work resources. 

9. You can check the “Leveling can create splits in remaining work” checkbox to allow Project to split a 

task, or work assignment, in order to resolve resource overallocation. 

10. If you are using Microsoft Project Professional, you may also see a “Level resources with the proposed 

booking type” checkbox. You will most often leave this checkbox cleared when leveling resources. 

11. You can also check the “Level manually scheduled tasks” checkbox to include manually scheduled 

tasks in the leveling process within this project file. 

12. Next, click the “Level All” button when you are ready to level the entire project file. Doing this 

corresponds to clicking the “Level All” button in the “Level” group on the “Resource” tab in the Ribbon. 

13. Note that you can click the “Level Selection” and “Level Resource” buttons in this same button group to 

level a selected task or resource within your project file if you wish to manually level resources. 

14. If you decide to manually level each resource or task individually within a project file, you can also use 

the “Next Overallocation” button in this group to select the next resource overallocation to resolve. 

15. You can also clear a resource leveling that you have applied by clicking the “Clear Leveling” button in 

this button group. When you do this, a “Clear Leveling” dialog box will appear where you can choose 

either “Entire project” or “Selected tasks.” Simply make your choice, and then click the “OK” button to 

remove the resource leveling that you have applied. Sa
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ACTIONS- 

Advanced Project Tracking 
MONITORING PROJECT COSTS: 

 

1. You can see much of the cost data that you need in the “Cost” table in the table view of your project file. 

You can switch the view of your project file to display this data easily. To do this, click into the table 

within the “Gantt Chart” view. Then click the “Tables” drop-down button in the “Data” group on the 

“View” tab in the Ribbon and select the “Cost” command from the drop-down menu. 

2. Remember that you can select the “Entry” command from this same drop-down menu to reset the 

display of the table area within the view to the task entry view when finished examining costs, if desired. 

3. Generally, some of the most important costs that are requested regarding a project are shown in the 

“Costs” table. You can see baseline costs, which are the scheduled costs that were saved as part of the 

project baseline. You can also see current costs, which are the costs that are scheduled for the task. 

After costs have been incurred, this shows the actual costs plus remaining costs. This information is 

displayed in the “Costs” or “Total Costs” column. You can also see the actual costs, which are the costs 

that have been incurred for tasks, assignments, and resources. You can also see remaining costs, 

which is the difference between the current costs and the actual costs for the task, assignment, or 

resource. 

MONITORING PROJECT STATISTICS: 

 

1. As you make adjustments to your project file, you should check your project statistics and finish date. 

You can access this type of information within your project file by clicking the “Project Information” 

button within the “Properties” group on the “Project” tab within the Ribbon in order to open the “Project 

Information” dialog box. 

2. Here you will see the scheduled finish date of the project shown in the “Finish date” field. This is 

important to keep track of as you level resources and adjust the tasks within your project file. 

3. Also notice that you can click the “Statistics…” button to display the “Project Statistics” dialog box for 

your project file. 

4. This dialog box shows the “Current,” “Baseline,” “Actual,” and “Variance” for the “Start” and “Finish” 

dates of your project file. You can also see the “Current,” “Baseline,” “Actual,” and “Remaining” values 

for the project file‟s “Duration,” “Work,” and “Cost.” 

5. When you are finished viewing this data, click the “Close” button to close the dialog box. 
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EXERCISES- 

Advanced Project Tracking 
Purpose: 

 

1. To be able to find advanced project information for reporting purposes.  

Exercises: 

 

1. Open the “My Project” project file that contains the saved changes that were made to the file through 

the end of the previous chapter‟s exercises. 

2. Click the “Gantt Chart” drop-down button in the “View” group on the “Task” tab and then select the 

“Resource Usage” command in order to view the resource assignments made to tasks within the 

project file. 

3. Click the “Tables” drop-down button in the “Data” group on the “View” tab in the Ribbon and select 

the “Cost” command from the drop-down menu in order to display cost data for the resources. Notice 

the increase to the “Cost” field versus the “Baseline Cost” for the “Jon Doe” resource in the project. 

This is due to the “pay raise” that was assigned mid-project from the last chapter‟s exercise. 

4. Click the “Tables” drop-down button in the “Data” group on the “View” tab in the Ribbon and select 

the “Usage” command from the drop-down menu to change the display back to its original style. 

5. Click the “Gantt Chart” drop-down button in the “View” group on the “Task” tab and then select the 

“Gantt Chart” command to display the Gantt Chart view of the project file. 

6. Click the “Project Information” button in the “Properties” group on the “Project” tab within the Ribbon 

to view the “Project Information” dialog box. 

7. Click the “Statistics…” button within the “Project Information” dialog box. 

8. Review the project‟s statistics, and then click the “Close” button within the “Project Statistics for „My 

Project‟” dialog box. 

9. Click the “Save” button within the Quick Access toolbar to save your changes. 

10. Click the “x” in the upper-right corner of the project file window to close the sample project file that 

you just saved. You will continue to use this file to complete the upcoming sequential 

exercises throughout this entire course. Each exercise builds upon the previous exercise, so 

please complete them in the order given to maximize your overall learning experience. 
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CHAPTER 11- 

Advanced Project Tools 

11.1- Using the Organizer 

 

11.2- Making Macros 

 

11.3- Customizing the Ribbon 

 

11.4- Creating and Linking Resource Pools 

 

11.5- Using and Updating Resource Pools 

 

11.6- Consolidating and Linking Multiple Projects 
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Advanced Project Tools 

11.1- Using the Organizer: 

 

 The Organizer within Microsoft Project allows you to transfer views and other defined objects 

between opened project files. To do this, first open the project files between which you want to transfer the 

custom project file objects. Then click the “File” tab in the Ribbon and select the “Info” command from the 

choices shown at the left side of the backstage view. In the area to the right, you can then click the 

“Organize Global Template” button to open the “Organizer” dialog box. Within the “Organizer” dialog box, 

you can see the various objects that you can import and export grouped by object category and displayed 

on the tabs within the dialog box. 

 First, click on the name of the tab that contains the type of object that you wish to transfer from one 

project file to another. Next, use the left “(Object name) available in:” drop-down to select the name of the 

project file that contains the specific object that you want to export into another opened project file. Next, 

use the right “(Object name) available in:” drop-down to select the name of the project file into which you 

want to copy the specific object. 

 At this point, you should see the name of the object to transfer shown in the listing at the left side in 

the tab. Click on the name of the specific object to transfer, and then click the “Copy >>” button to copy the 

object into the listing at the right side of the tab. Doing this will copy the selected object from the project file 

that you selected at the left side of the tab into the project file that you selected at the right side of the tab. 

 While you have the “Organizer” window opened, note the other functions that are available within 

this dialog box. You can click the “Close/Cancel” toggle button to close the dialog box. You can also use the 

“Rename…” and “Delete” buttons to rename or delete selected items in the lists. This is a very handy way of 

deleting custom views that you have created by accident from the list of available views within a project file. 

Also note that you can select items from the right list and then click the “<< Copy” button to copy items from 

the right list to the left list, if desired. 

  Also note that if you copy objects into either the “Global.MPT” or “Global (+non-cached enterprise)” 

project files, you are actually copying objects into the global template that is used as the basis for new 

project files created in the future. If you are using Project Server, you may not be able to copy elements into 

the “Global (+non-cached enterprise)” template due to network security settings. However, if using a stand-

alone copy of Microsoft Project, you can copy elements into the “Global.MPT” file. Take care when adding, 

renaming, deleting, or otherwise editing elements within the global template files, as this will affect the 

content available in future project files created from the template. 

11.2- Making Macros: 

 

 Macros are little programs that you can record that automate repetitive tasks for you. They are 

basically little programs! What a macro does is it records your keystrokes as you perform some sort of task 

routine and saves your keystrokes as a Visual Basic Module, which is a type of small program. When you 

play back the macro later, it will repeat your keystrokes and thus repeat your actions. This is why they are 

great for instantly performing menial tasks. 

 You use the macro recorder to record your macros.  To start recording a macro, click the “Macros” 

drop-down button in the “Macros” button group in the “View” tab within the Ribbon. Then select the “Record 

Macro…” command from the drop-down menu that appears. 

 In the “Record Macro” dialog box that appears, type the name that you want to give to your new 

macro into the “Macro name:” text box. Macro names cannot contain any spaces. 

 Note that you can also create a custom keyboard shortcut to use in conjunction with the “Ctrl” key by 

typing the desired shortcut key letter into the text box next to the “Ctrl + .” If you decide to do this, make sure 

you don‟t overwrite an existing shortcut! For example the shortcut character of “p” would be a bad choice as 
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Advanced Project Tools 

11.2- Making Macros (cont.): 

 

“Ctrl + P” is already a keyboard shortcut for the “Print” command. If you aren‟t familiar with the keyboard 

shortcuts, it may be better if you don‟t assign one. 

 Next, select where you want to save the macro by choosing the desired project file from the “Store 

macro in:” drop-down. If you do not change it, it will default to saving the macro into the “Global File.” This is 

important because a macro can only be run if it is saved into an open project file or stored into the “Global 

File,” which contains the default project template objects. 

 Next, you can type a description of the function of this macro into the “Description” field. This is an 

optional step, but it can help clarify the purpose of the macro if the name is unclear. 

 The types of cell references that you make while recording a macro can also be adjusted. If 

recording a macro using relative references, the movements that are recorded are noted in relative terms. 

For example, a macro that moves the active cell down one row, recorded in relative terms, will always move 

the active cell one row down from whichever row is initially selected when the macro is run in the future. 

 If you record a macro using absolute references, the macro will always select and move to the exact 

same cells in the project file, regardless of which cell is initially selected when the macro is run in the future. 

You can adjust which type of referencing is used when recording the new macro by selecting the desired 

options in the “Row References” and “Column References” sections. By default, macros will record using 

relative references for row references and absolute references for column references. When you are ready 

to start recording your actions, click the “OK” button. 

 At this point, all of the keystrokes that you enter will now be recorded. So be careful what actions 

you perform as any mistakes that you make will also be included as part of the macro. If you do make a 

mistake though, you can simply stop recording the macro and delete it. Then you may try again. 

 To stop recording your actions once you have finished, just click the “Macros” button in the “Macros” 

button group on the “View” tab in the Ribbon and then select the “Stop Recording” command from the drop-

down menu that appears. 

 To run a macro that you have recorded, click the “Macros” button in the “Macros” button group on 

the “View” tab in the Ribbon and then select the “View Macros” command from the drop-down menu that 

appears. That will then launch the “Macros” dialog box. Within this dialog box, you will see a listing of any 

available macros. Select the name of the macro that you want to run, and then click the “Run” button at the 

right side of the dialog box to run the selected macro. 

 Finally, you can delete macros that you have stored in a workbook. To do this, click the “Macros” 

button in the “Macros” button group on the “View” tab in the Ribbon and then select the “View Macros” 

command from the drop-down menu that appears. In the “Macro” dialog box, select the name of the macro 

that you want to delete from the list of macros. Then click the “Delete” button at the right side of this dialog 

box. You will be prompted to confirm the deletion of the macro by clicking “Yes” in the pop-up window that 

appears. You can cancel the deletion by clicking “No,” instead. 

11.3- Customizing the Ribbon: 

 

 You can customize the Ribbon to add custom tabs, button groups, and buttons to the Ribbon. To do 

this, click the “File” tab in the Ribbon and then click the “Options” command at the left side of the backstage 

view to open the “Project Options” dialog box. At the left side of this dialog box, click the “Customize 

Ribbon” command to then display your customization options in the area to the right. 

 In the area to the right are two lists. The far right list is an outlined listing of the tabs, button groups, 

and commands found within the Ribbon. To the left of that is a listing of the various command that you can 

add to the Ribbon. To create a new tab within the Ribbon, click the “New Tab” button that appears below 
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Advanced Project Tools 

11.3- Customizing the Ribbon (cont.): 

 

the far right list. You will see a new tab appear within the list with a new button group associated with it. You 

can click the “New Tab (Custom)” item within the list and then click the “Rename…” button below the list in 

order to open the “Rename” dialog box. Simply type the name you wish to give to the tab into the “Display 

name:” field and then click the “OK” button to change the name of the tab. You can then click the “New 

Group (Custom)” item and then click the “Rename…” button again to repeat the process and rename the 

default button group. 

 You can then add buttons into the selected button group. To do this, simply select the name of the 

button group that you just renamed in the far right list. Then use the drop-down that appears over the list to 

the left to choose which command buttons to view in the list below. It defaults to “Popular Commands” but 

you can change it, as desired. If you wish to see all commands available in the listing below, choose the “All 

Commands” choice from the drop-down. You will then see the selected types of commands appear in the 

list below. Find the command button that you want to add to your button group within this list and then click 

on it to select it. Then click the “Add>>” button in the middle of the window to add the selected command 

into the selected button group that appears in the far right list. Repeat this, as needed, until you have added 

all of your desired tabs, groups, and commands to the Ribbon. 

 If you wish to reset your Ribbon to its default settings and remove any customizations made to your 

Ribbon, you can click the “Reset” drop-down button that appears below the far right list and then choose the 

“Reset all customizations” choice to reset your Ribbon to its default appearance. This can be useful to reset 

changes made to your Ribbon by another user, if that occurs. 

11.4- Creating and Linking Resource Pools: 

 

 You can use a resource pool to create a single list of resources that can be scheduled amongst 

multiple projects. While this can be helpful in almost any multi-project situation, it is especially helpful when 

scheduling multiple projects amongst multiple project managers in a networked environment. There are 

many benefits to using a shared resource pool for projects. When using resource pools, you only need to 

enter the resource information into the resource pool once. From there, you can link the resource pool to 

multiple projects, called sharer projects, as needed. Another benefit is that you can view resource 

assignments from multiple projects in a single location. This also allows you the ability to more easily see 

overallocated resources amongst multiple projects, even if a resource is underallocated within a single 

project. These are just a few benefits of using resource pools. 

 Before you can use a resource pool amongst multiple projects, you must first create the resource 

pool. This file is often placed in a shared network folder for ease of access between all project managers 

who need to link their sharer projects to the resource pool. Also, any project file can be used as a resource 

pool. However, it is most often a project file that contains no tasks, as the whole point of this file is to serve 

as a shared resource pool. Also, it is a good idea to save the resource pool with a file name that makes it 

perfectly clear that this file is a resource pool, and not simply another project file. 

 Once you have created and saved a blank project file with the desired name, you then link the 

desired sharer project files to the dedicated shared resource pool. You can do this by opening the resource 

pool project file as well as the other project files that you want to link to the shared resource pool. Within 

each sharer project file, you then click the “Resource Pool” drop-down button in the “Assignments” button 

group on the “Resource” tab in the Ribbon and then select the “Share Resources…” command.  

 In the “Share Resources” dialog box that opens, select the “Use resources” option button. Then, use 

the “From:” drop-down to select the name of the shared resource pool project file that you have open. Next, 

in the “On conflict with calendar or resource information” section, select the “Pool takes precedence” option 
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Advanced Project Tools 

11.4- Creating and Linking Resource Pools (cont.): 

 

to make the sharer plan use resource information from the resource pool over its own if there is a conflict. 

 Once you have set the desired options in the “Share Resources” dialog box, you can then click the 

“OK” button to apply them. After that, you can then see the resources from the “sharer” plans shown in the 

main resource pool project file. You can use the shared resource pool file to check for things such as 

resource overallocations amongst project files that share resources. 

11.5- Using and Updating Resource Pools: 

 

 Once you have a shared resource pool linked to sharer plans, you can open the resource pool in 

order to examine the resource allocations in the “Resource Sheet” view. If you split the pane, you can see 

resource allocations amongst multiple projects for any selected resources. You can then use the 

information to correct resource allocation issues that can arise. 

 In addition to managing resource allocations, you can also change working schedules or pay rates 

for any resources listed in the resource pool in order to make a universal change to all of the sharer project 

files. Note that in order to update the sharer plans with the most recent changes that are made to a resource 

pool, you must open the sharer plans you want to update while you have the resource pool file open, but 

after you have made the changes that you want to enforce within the resource pool. 

 When using linked projects, note that if you wish to make changes to resource details, you should 

open the linked resource pool project file as “read-write,” and then make the changes. When you open a 

linked resource pool, a dialog box appears to ask you if you wish to open the file as a “read only” copy or a 

“read-write” copy. When changing resource details, such as the “Units” available for a resource, you need to 

open the file as “read-write.” After you save these changes, the users of the linked sharer projects will have 

the changes to the resources available to their project files after you close the shared resource file. 

 Many changes within a project file, however, are simple assignment changes. When using the 

sharer project files that are linked to the shared resource pool, you should open these files as “read only” 

and then click the “Resource Pool” drop-down button in the “Assignments” button group on the “Resource” 

tab in the Ribbon and choose the “Update Resource Pool” command to update resource assignment 

information within the shared resource pool. This feature allows users across a network to have 

simultaneous access to their sharer project files where they can make assignment changes and then save 

and update that information in the resource pool without opening the resource pool file as “read-write,” 

which actually prevents other users from making their assignment changes. When you initially open a 

sharer project file, the “Open Resource Pool Information” dialog box will appear. In this dialog box, you can 

select the “Open resource pool to see assignments across all sharer files” option to enable all current 

assignment changes to the shared resources to appear within your sharer project file. This also open the 

resource pool file as a “read-only” copy in the background. You can then make the task assignment 

changes as needed. 

 When you are finished editing assignment details, click the “Resource Pool” drop-down button in the 

“Assignments” button group on the “Resource” tab in the Ribbon and then select the “Update Resource 

Pool” command to update the resource pool with the new assignment information from your sharer project 

file. Note that if you make changes and then click the “Save” button to save these changes, Microsoft 

Project will prompt you to update the resource pool with your changes. In the message box that appears, 

you can click the “OK” button to save your changes to the resource pool file. 

 In the future, if a sharer project file that was linked to a resource pool file is deleted, the assignment 

detail information from the deleted project will still appear within the shared resource pool file. To clear this 

data from the resource pool file, you must break the link to the resource pool file. As when making changes 
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Advanced Project Tools 

11.5- Using and Updating Resource Pools (cont.): 

 

to resource details, you will need to open the resource pool file in “read-write” mode. Then click the 

“Resource Pool” drop-down button in the “Assignments” button group on the “Resource” tab in the Ribbon 

and select the “Share Resources…” command to open the “Share Resources” dialog box. In this dialog box, 

select the name of the deleted sharer project file that you want to clear from the resource pool, and then 

click the “Break Link” button.  You can then click the “OK” button to apply your changes. 

11.6- Consolidating and Linking Multiple Projects: 

 

 Microsoft Project also delivers the ability to create a master project file that contains linked copies of 

other project files, often called subprojects. Also, since the subproject copies are linked to their original 

project files, when changes are made to the original files, these changes will then appear in the master 

project file then next time it is opened. This is a great feature for people who need to manage and 

coordinate multiple, smaller projects. 

 In addition to this feature, you can also create task links between these linked subprojects within the 

master project file. This is a terrific feature that allows you to coordinate related tasks between projects files. 

For example, the completion of a task within one project can share a “Finish-to-Start” relationship with 

another task in a separate project file. When the first task is completed, the second task in the related 

project can then commence. For people who need to coordinate multiple projects that share task 

interdependencies, this tool is absolutely essential. After you have created your master project file and 

linked the necessary subproject files, you simply create the task links between the files as you normally 

would. Note that this draws task dependency arrows between the tasks in the master project file. Also, if 

you open the original, individual project files that are linked into the master project file, you will see gray 

“ghost tasks” for the linked tasks between the project files. These are simply gray task bars that appear to 

indicate that the task shares a dependency with another task in a separate project file. 

 In order to insert a subproject into master project file, first select the row within the master project file 

where you want the subproject data to be displayed. Next, click the “Subproject” button in the “Insert” group 

on the “Project tab within the Ribbon in order to open the “Insert Project” dialog box. Use this dialog box to 

locate the project file that you want to copy into this project file. When you see the project that you want, 

click on it to select it, and then click the “Insert” button to insert the subproject as a linked copy into the main 

project file. You then repeat this process until you have linked all of the necessary subprojects into the 

master project file. You can then create any links between the project files, as needed, within the master 

project file. 
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ACTIONS- 

Advanced Project Tools 
USING THE ORGANIZER: 

 

1. To transfer views and other defined objects between opened project files, first open the project files 

between which you want to transfer the custom project file objects. 

2. Click the “File” tab in the Ribbon and select the “Info” command from the choices shown at the left side 

of the backstage view. In the area to the right, you can then click the “Organize Global Template” button 

to open the “Organizer” dialog box. 

3. Click on the name of the tab that contains the type of object that you wish to transfer from one project 

file to another. 

4. Next, use the left “(Object name) available in:” drop-down to select the name of the project file that 

contains the specific object that you want to export into another opened project file. 

5. Next, use the right “(Object name) available in:” drop-down to select the name of the project file into 

which you want to copy the specific object. 

6. At this point, you should see the name of the object to transfer shown in the listing at the left side in the 

tab. Click on the name of the specific object to transfer, and then click the “Copy >>” button to copy the 

object into the listing at the right side of the tab. 

7. Note that you can click the “Close/Cancel” toggle button to close the dialog box. 

8. You can also use the “Rename…” and “Delete” buttons to rename or delete selected items in the lists. 

9. Also note that you can select items from the right list and then click the “<< Copy” button to copy items 

from the right list to the left list, if desired. 

MAKING MACROS: 

 

1. To start recording a macro, click the “Macros” drop-down button in the “Macros” button group in the 

“View” tab within the Ribbon. 

2. Select the “Record Macro…” command from the drop-down menu that appears. 

3. In the “Record Macro” dialog box that appears, type the name that you want to give to your new macro 

into the “Macro name:” text box. Macro names cannot contain any spaces. 

4. Note that you can also create a custom keyboard shortcut to use in conjunction with the “Ctrl” key by 

typing the desired shortcut key letter into the text box next to the “Ctrl + .” If you decide to do this, make 

sure you don‟t overwrite an existing shortcut! 

5. Next, select where you want to save the macro by choosing the desired project file from the “Store 

macro in:” drop-down. If you do not change it, it will default to saving the macro into the “Global File.” 

This is important because a macro can only be run if it is saved into an open project file or stored into 

the “Global File,” which contains the default project template objects. 

6. Next, you can type a description of the function of this macro into the “Description” field. This is an 

optional step, but it can help clarify the purpose of the macro if the name is unclear. 

7. You can adjust which type of referencing is used when recording the new macro by selecting the 

desired options in the “Row References” and “Column References” sections. 

8. When you are ready to start recording your actions, click “OK.” 

9. At this point, all of the actions that you enter will now be recorded. Be careful what actions you perform 

as any mistakes that you make will also be included as part of the macro. If you do make a mistake 

though, you can simply stop recording the macro and delete it. Then you may try again. 

10. To stop recording your actions once you have finished, just click the “Macros” button in the “Macros” 

button group on the “View” tab in the Ribbon and then select the “Stop Recording” command from the 

drop-down menu that appears. 
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ACTIONS- 

Advanced Project Tools 
MAKING MACROS- CONT.: 

 

11. To run a macro that you have recorded, click the “Macros” button in the “Macros” button group on the 

“View” tab in the Ribbon and then select the “View Macros” command from the drop-down menu that 

appears. 

12. That will then launch the “Macros” dialog box. Within this dialog box, you will see a listing of any 

available macros. Select the name of the macro that you want to run, and then click the “Run” button at 

the right side of the dialog box to run the selected macro. 

13. To delete macros click the “Macros” button in the “Macros” button group on the “View” tab in the Ribbon 

and then select the “View Macros” command from the drop-down menu that appears. 

14. In the “Macro” dialog box, select the name of the macro that you want to delete from the list of macros. 

Then click the “Delete” button at the right side of this dialog box. 

15. You will be prompted to confirm the deletion of the macro by clicking “Yes” in the pop-up window that 

appears. You can cancel the deletion by clicking “No,” instead. 

CUSTOMIZING THE RIBBON: 

 

1. Click the “File” tab in the Ribbon and then click the “Options” command at the left side of the backstage 

view to open the “Project Options” dialog box. 

2. At the left side of this dialog box, click the “Customize Ribbon” command to then display your 

customization options in the area to the right. 

3. To create a new tab within the Ribbon, click the “New Tab” button that appears below the far right list. 

You will see a new tab appear within the list with a new button group associated with it. 

4. You can click the “New Tab (Custom)” item within the list and then click the “Rename…” button below 

the list in order to open the “Rename” dialog box. Simply type the name you wish to give to the tab into 

the “Display name:” field and then click the “OK” button to change the name of the tab. 

5. You can then click the “New Group (Custom)” item and then click the “Rename…” button again to 

repeat the process and rename the default button group. 

6. To add buttons to the selected button group, select the name of the button group and then find the 

command button that you want to add from the list that appears to the left. 

7. When you find it, click on it to select it and then click the “Add>>” button in the middle of the window to 

add the selected command into the selected button group that appears in the far right list. 

8. Repeat this, as needed, until you have added all of your desired commands to the Ribbon. 

9. To remove all customizations made to your Ribbon, click the “Reset” drop-down button that appears 

below the far right list and then choose the “Reset all customizations” choice. 

LINKING A SHARER FILE TO A RESOURCE POOL: 

 

1. Within each sharer project file, click the “Resource Pool” drop-down button in the “Assignments” button 

group on the “Resource” tab in the Ribbon and then select the “Share Resources…” command. 

2. In the “Share Resources” dialog box that opens, select the “Use resources” option button. Then, use the 

“From:” drop-down to select the name of the shared resource pool file that you have created. 

3. Next, in the “On conflict with calendar or resource information” section, select the “Pool takes 

precedence” option in order to make the sharer plan use information from the resource pool over its own 

resource sheet if there is a conflict. 

 

(cont.) Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



36 Advanced Project ©TeachUcomp, Inc. 

ACTIONS- 

Advanced Project Tools 
LINKING A SHARER FILE TO A RESOURCE POOL- CONT.: 

 

4. Once you have set the desired options in the “Share Resources” dialog box, you can then click the “OK” 

button to apply them. You can then see the resources from the “sharer” plans shown in the main 

resource pool project file. 

USING AND UPDATING RESOURCE POOL AND SHARER FILES: 

 

1. Once you have a shared resource pool linked to sharer plans, you can open the resource pool in order 

to examine the resource allocations in the “Resource Sheet” view. If you use the “Details” pane at the 

bottom of the window, you can see resource allocations amongst multiple projects for any selected 

resources. You can then use the information to correct resource allocation issues that can arise. 

2. To change resource information details for any resources listed in the resource pool in order to make a 

universal change to all of the sharer project files, you must open the sharer plans you want to update 

while you have the resource pool file open, but after you have made the changes that you want to 

enforce within the resource pool. 

3. If you wish to make changes to resource details, you must open the linked resource pool project file as 

“read-write,” and then make the changes. When you open a linked resource pool, a dialog box appears 

to ask you if you wish to open the file as a “read only” copy or a “read-write” copy. When changing 

resource details, such as the “Units” available for a resource, you need to open the file as “read-write.” 

4. To make resource assignment changes within a sharer project file that is linked to the shared resource 

pool, you should open the resource pool file as “read only” and then click the “Resource Pool” drop-

down button in the “Assignments” button group on the “Resource” tab in the Ribbon and choose the 

“Update Resource Pool” command to update resource assignment information within the shared 

resource pool. 

5. When you initially open a sharer project file, the “Open Resource Pool Information” dialog box will 

appear. In this dialog box, you can select the “Open resource pool to see assignments across all sharer 

files” option to enable all current assignment changes to the shared resources to appear within your 

sharer project file. This also open the resource pool file as a “read-only” copy in the background. You 

can then make the task assignment changes as needed. 

6. When you are finished editing assignment details, you can click the “Resource Pool” drop-down button 

in the “Assignments” button group on the “Resource” tab in the Ribbon and choose the “Update 

Resource Pool” command to update the resource pool with the new assignment information from your 

sharer project file. 

7. Note that if you make changes and then click the “Save” button to save these changes, Microsoft Project 

will prompt you to update the resource pool with your changes. In the message box that appears, you 

can click the “OK” button to save your changes to the resource pool file. 

8. In the future, if a sharer project file that was linked to a resource pool file is deleted, the assignment 

detail information from the deleted project will still appear within the shared resource pool file. To clear 

this data from the resource pool file, you must break the link to the resource pool file. As when making 

changes to resource details, you will need to open the resource pool file in “read-write” mode. 

9. Then click the “Resource Pool” drop-down button in the “Assignments” button group on the “Resource” 

tab in the Ribbon and select the “Share Resources…” command to open the “Share Resources” dialog 

box. In this dialog box, select the name of the deleted sharer project file that you want to clear from the 

resource pool, and then click the “Break Link” button.  

10. You can then click the “OK” button to apply your changes. Sa
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ACTIONS- 

Advanced Project Tools 
CONSOLIDATING AND LINKING MULTIPLE PROJECTS: 

 

1. In order to insert a project file, first select the row within the master project file where you want the 

subproject data to be displayed. 

2. Click the “Subproject” button in the “Insert” group on the “Project tab within the Ribbon in order to open 

the “Insert Project” dialog box. 

3. Use this dialog box to locate the project file that you want to copy into this project file. 

4. When you see the project that you want, click on it to select it, and then click the “Insert” button to insert 

the subproject as a linked copy into the main project file. 

5. You then repeat this process until you have linked all of the necessary subprojects into the master 

project file. 

6. You can then create any links between the project files, as needed, within the master project file. 
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EXERCISES- 

Advanced Project Tools 
Purpose: 

 

1. There are no exercises for this chapter, please continue to the next chapter to finish the exercises.  

Exercises: 

 

1. None 
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CHAPTER 12- 

Earned Value Analysis 

12.1- Using Earned Value Analysis 
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Earned Value Analysis 

12.1- Using Earned Value Analysis: 

 

 One of the many benefits of project management is the ability to perform earned value analysis. 

Note that this term is also often referred to as earned value management. This type of analysis allows you 

to view project statistics that reveal the overall health of the project based in terms of time and cost, while 

assisting you in revealing trends that can often be indicative of the eventual success or failure of the project. 

When you view information from earned value analysis within your project file, you compare figures at a 

specified date in the project file against figure from one of the saved baselines that you have within the 

project file. Note that you must have saved at least one baseline copy of the project file in order to show 

earned value analysis results. You must also have accurately recorded the actual work and costs within the 

project file. In addition, you must select a “status date,” so that Microsoft Office Project can compare the 

baseline values against the values recorded as of the status date. You can specify the “status date” by 

clicking the “Status Date:” calendar button within the “Status” group on the “Project” tab within the Ribbon. 

In the “Status Date” dialog box that appears, use the calendar drop-down to select a desired status date or 

simply type a date into the text box shown. Then click the “OK” button to set the status date. 

 Once you have accomplished these tasks, you can easily view the earned value schedule 

indicators for your project by clicking the “Tables” button in the “Data” group on the “View” tab in the 

Ribbon and choosing the “More Tables…” command from the drop-down menu. In the “More Tables” dialog 

box that appears, you can then select the “Earned Value Schedule Indicators” choice and then click the 

“Apply” button to display the values in the Gantt Chart view. Remember that these values are all set as of 

the selected “status date” for the project file. You can change that date in the “Project Information” dialog 

box to change the numbers shown in this view. 

 In this view you will see the following data: the planned value (PV), which is the budgeted cost of 

the work scheduled as of the status date; the earned value (EV), which is the budgeted cost of the work 

performed as of the status date; the schedule variance (SV), which is the difference between the EV and 

the PV values; the schedule variance percentage (SV%), which is the ratio of the SV to the PV expressed 

as a percentage; and the schedule performance index (SPI), which is an index value that basically shows 

how many cents of actual worth was accomplished by the status date for every dollar (1.00) that you 

planned to spend. 

 You can also view the earned value cost indicators for your project file in the table view of the 

Gantt Chart, as well. You can switch to this view by clicking the “Tables” button in the “Data” group on the 

“View” tab in the Ribbon and choosing the “More Tables…” command from the drop-down menu. In the 

“More Tables” dialog box that appears, you can then select the “Earned Value Cost Indicators” choice and 

then click the “Apply” button to display the values in the Gantt Chart view. As with the earned value 

schedule indicators, you will see the planned value (PV) and earned value (EV) columns. Also within this 

view you will find: the cost variance (CV), which is the difference between the EV and the actual cost of 

work performed as of the status date; the cost variance percentage (CV%), which is the ratio of cost 

variance to PV expressed as a percentage; the cost performance index (CPI), which shows how many 

cents worth of work was accomplished for each dollars worth of work (1.00) that was spent; the budget at 

completion (BAC), which is the total baseline cost for the task; the estimate at completion (EAC), which 

represents the forecasted cost to complete a task; the variance at completion (VAC), which is the 

difference between the BAC and the EAC; and the “to complete performance index” (TCPI), which 

shows the ratio of work remaining to the budget remaining as of the status date. 

 Note that, for users of Microsoft Office Project 2010 who also have Microsoft Excel 2003 or later 

installed, you can also create a visual “Earned Value Over Time” report. This is one of the many Excel 

reports that are available within Project. This reports shows a standard “S-curve” line chart that traces the 

cumulative values of three key indicators over time. The three indicators shown in this report are: the actual 
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Earned Value Analysis 

12.1- Using Earned Value Analysis (cont.): 

 

cost of work performed (AC); the budgeted cost of work scheduled (Planned Value), and the budgeted cost 

of work performed (Earned Value). Note that if you are using a version of Project prior to 2007, you can still 

generate a report like this by using the “Analyze Timescaled Data” add-in within Excel as a separate task. 

 To create this report in Microsoft Office Project, click the “Visual Reports” button within the “Reports” 

group on the “Project” tab within the Ribbon. This causes the “Visual Reports” dialog box to appear. Note 

that you must have the “Microsoft Excel” checkbox checked at the top of this dialog box in order to show 

templates from Excel within the dialog box. Also, you must also have Microsoft Excel 2003 or later also 

installed on your computer. 

 Note that there are many types of reports that are available for use within Project. To open the 

“Earned Value Over Time” report, click the “Assignment Usage” tab and then click on the name of the report 

to select it. You can then click the “View” button within the “Visual Reports” dialog box to open Microsoft 

Excel and show the resultant chart and PivotTable for the report. Once the report has been created in 

Excel, you can then manipulate it as needed to display the desired data. When you have finished creating 

reports in Microsoft Project, you can click the “Close” button within the “Visual Reports” dialog box. 
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ACTIONS- 

Earned Value Analysis 
VIEWING EARNED VALUE ANALYSIS DATA: 

 

1. Note that you must have saved at least one baseline copy of the project file in order to show earned 

value analysis results. You must also have accurately recorded the actual work and costs within the 

project file. In addition, you must select a “status date,” so that Microsoft Office Project can compare the 

baseline values against the values recorded as of the status date. 

2. You can specify the “status date” by clicking the “Status Date:” calendar button within the “Status” group 

on the “Project” tab within the Ribbon. In the “Status Date” dialog box that appears, use the calendar 

drop-down to select a desired status date or simply type a date into the text box shown. Then click the 

“OK” button to set the status date. 

3. Once you have accomplished these tasks, you can easily view the earned value schedule indicators for 

your project by clicking the “Tables” button in the “Data” group on the “View” tab in the Ribbon and 

choosing the “More Tables…” command from the drop-down menu. 

4. In the “More Tables” dialog box that appears, you can then select the “Earned Value Schedule 

Indicators” choice and then click the “Apply” button to display the values in the Gantt Chart view. 

5. Remember that these values are all set as of the selected “status date” for the project file. You can 

change that date in the “Project Information” dialog box to change the numbers shown in this view. 

6. You can also view the earned value cost indicators for your project file by clicking the “Tables” button in 

the “Data” group on the “View” tab in the Ribbon and choosing the “More Tables…” command from the 

drop-down menu. 

7. In the “More Tables” dialog box that appears, you can then select the “Earned Value Cost Indicators” 

choice and then click the “Apply” button to display the values in the Gantt Chart view. 

8. Note that, for users who also have Microsoft Excel 2003 or later installed, you can create a visual 

“Earned Value Over Time” report. This is one of the Excel reports that are available within Project. 

9. To create this report in Microsoft Office Project, click the “Visual Reports” button within the “Reports” 

group on the “Project” tab within the Ribbon. This causes the “Visual Reports” dialog box to appear. 

Note that you must have the “Microsoft Excel” checkbox that appears at the top of this dialog box 

checked in order to show templates from Excel within the dialog box. 

10. To open the “Earned Value Over Time” report, click the “Assignment Usage” tab and then click on the 

name of the report to select it. 

11. You can then click the “View” button within the “Visual Reports” dialog box to open Microsoft Excel and 

show the resultant chart and PivotTable for the report. 

12. Once the report has been created, you can then change it as needed to display the desired data. 

13. When you have finished creating reports in Microsoft Project, you can click the “Close” button within the 

“Visual Reports” dialog box. 
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EXERCISES- 

Earned Value Analysis 
Purpose: 

 

1. To be able to display earned value analysis data within a project file.  

Exercises: 

 

1. Open the “My Project” project file that contains the saved changes that were made to the file through 

the end of the “Chapter 10” exercises. 

2. Click the “Tables” button in the “Data” group on the “View” tab in the Ribbon and choose the “More 

Tables…” command from the drop-down menu in order to display the “More Tables” dialog box. 

3. Select the “Earned Value Schedule Indicators” option within the list of choices shown, and then click 

the “Apply” button. Review the columns shown in this view. As you can see from the results, this 

project is perfectly on track with earned value as of the status date. 

4. Click the “Tables” button in the “Data” group on the “View” tab in the Ribbon and choose the “More 

Tables…” command from the drop-down menu in order to display the “More Tables” dialog box. 

5. Select the “Earned Value Cost Indicators” option within the list of choices shown, and then click the 

“Apply” button. Review the columns shown in this view. As you can see from the results, this project 

is perfectly on track with project costs as of the status date. 

6. Click the “Tables” button in the “Data” group on the “View” tab in the Ribbon and choose the “Entry” 

command from the drop-down menu in order to display the default “Gantt Chart” view. 

7. Click the “Save” button in the Quick Access toolbar. 

8. Click the “x” in the upper-right corner of the project file window to close the sample project file. 
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Project Keyboard Shortcuts 

Category: Using Views and Windows 

Command Key 

Activate Window Menu Alt + Spacebar 

Activate cell entry F2 

Activate Key Badge System or Alt 

Activate Project File Menu Alt + F 

Activate Window Split Alt + W + E + T 

Close Program Alt + F4 

Show ‘Field Settings’ dialog box Alt + F3 

Open New Window Shift + F11 

Reduce selection to one field Shift + Backspace 

Reset Sort to Task ID Order Shift + F3 

Select a Drawing Object F6 

Show Task Information Shift + F2 

Show Resource Information Shift + F2 

Show Assignment Information Shift + F2 

Toggle ‘Add to Selection’ Mode Shift + F8 

Toggle AutoCalculate Ctrl + F9 

Toggle ‘Extend Selection’ Mode F8 

Move by page in Print Preview Up, Down, Left, Right Arrows 

Category: Outlining Project Tasks 

Command Key 

Hide Subtasks Alt + Shift + Hyphen 

Show Subtasks Alt + Shift + = (equal sign) 

Show All Tasks Alt + Shift + * (on number pad) 

Demote Selected Task Alt + Shift + Right Arrow 

Promote Selected Task Alt+ Shift + Left Arrow 

Category: Selecting & Editing in Task/Resource Form 

Command Key 

Move between fields at the bottom of a 

form 

Up, Down, Left, Right 

Arrow Keys 

Move to the next task or resource Enter 

Move to the previous task or resource Shift + Enter 

Category: Moving in the Sheet Views 

Command Key 

Move to beginning of a timescale 

view 

Alt + Home 

Move to the end of a project in 

timescale view 

Alt + End 

Move the timescale left Alt + Left Arrow 

Move the timescale right Alt + Right Arrow 

Move to the first field in a row Home or Ctrl + Left Arrow 

Move to the first row Ctrl + Up Arrow 

Move to the first field in the first 

row 

Ctrl + Home 

Move to the last field in a row End or Ctrl + Right Arrow 

Move to the last field in the last 

row 

Ctrl + End 

Move to the last row Ctrl + Down Arrow 

Cancel action Esc 

Undo Action Ctrl + Z 

Redo/Repeat Action Ctrl + Y 
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Project Keyboard Shortcuts 

Category: Selecting in the Sheet Views 

Command Key 

Extend one page down Shift + Page Down 

Extend one page up Shift + Page Up 

Extend down one row Shift + Down Arrow 

Extend up one row Shift + Up Arrow 

Extend to first field in row Shift + Home 

Extend to last field in row Shift + End 

Extend to start of information Ctrl + Shift + Home 

Extend to end of information Ctrl + Shift + End 

Extend to first row Ctrl + Shift + Up Arrow 

Extend to last row Ctrl + Shift + End Arrow 

Extend to first field in first row Ctrl + Shift + Home 

Extend to last field in last row Ctrl + Shift + End 

Select all columns and rows Ctrl + Shift + Spacebar 

Select a column Ctrl + Spacebar 

Select a row Shift + Spacebar 

Move one field down in a selection Enter 

Move one field up in a selection Shift + Enter 

Move one field right in a selection Tab 

Move one field left in a selection Shift + Tab 

Category: Editing in the Sheet Views 

Command Key 

Cancel an entry Esc 

Clear or reset field Ctrl + Delete 

Copy selected data Ctrl + C 

Cut selected data Ctrl + X 

Paste cut or copied data Ctrl + V 

Fill Down Ctrl + D 

Link Tasks Ctrl + F2 

Unlink Tasks Ctrl + Shift + F2 

Undo Ctrl + Z 

Category: Editing within the ‘Cell Entry’ Bar 

Command Key 

Accept entry Enter 

Cancel entry Esc 

Delete left character Backspace 

Delete right character Delete 

Delete right word Ctrl + Delete 

Extend selection to end of text Shift + End 

Extend selection to start of text Shift + Home 

Toggle ‘Overtype’ Mode Insert 

Category: Navigating in a Timescale View 

Command Key 

Move timescale one page left Alt + Page Up 

Move timescale one page right Alt + Page Down 

Move timescale to project start Alt + Home 

Move timescale to project finish Alt + End 

Scroll timescale left Alt + Left Arrow 

Scroll timescale right Alt + Right Arrow 

Show smaller time units Ctrl + / (on number 

pad) 

Show larger time units Ctrl + * (on number 

pad) 
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